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Answer Key6
Class

Logicode (Ver. 5.0)

	 Introduction to Mobile Apps

1.	 a. (ii) 	 b. (iii) 	 c. (i) 	 d. (iii) 	 e. (iii) 
2.	 a. Platform, Device 	 b. Web server, browser 	 c. Native, Web
	 d. Internet 
3.	 a. T 	 b. T 	 c. F 	 d. T 	 e. T 
4.	 a. Apps or Application Software 	 b. Apple 	 c. WhatsApp
	 d. Native, Web, and Hybrid apps 
5.	 a. Android is a type of operating system developed by Google and is used on smartphones and 

tablets.
	 b.	1.	 Netflix used for entertainment
		  2.	 Google Maps make your travel easier
		  3.	 Calculator used for calculating numbers  
	 c.	Communication apps allow us to communicate with each other by sending and receiving       

messages, information and opinions in the form of texts, videos, and audio. These apps also 
allow us to see the face of the person to whom we are talking. Examples of communication 
apps are Microsoft Teams, WhatsApp etc.

	 d.	Web apps: Web apps are actually web applications that give a user an experience similar to 
that of native apps. These apps cannot be installed via the Play Store or App Store. These are 
deployed on the web server. Hence, you need an extra app called a browser to access these 
apps on your mobile device. You also need an Internet connection to work with Web apps. 

		  Native apps: Apps that are developed for a specific platform (Operating System) and device 
are called Native apps. A native iOS app would not be able to work on Android, and an app 
developed for Android or Windows wouldn’t work on iOS systems. These apps can be installed 
from the app stores such as Google's Play Store or Apple's App Store.

6.	 a.	Lifestyle apps 

1.
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	 b.	Utility apps

	 c.	Lifestyle apps

	 d.	Educational apps

	 e.	Web app

	Formulas and Functions in Excel 2021

1.	 a. (iii) 	 b. (iv) 	 c. (iii) 	 d. (iii) 	 e. (iii)
2.	 a. 60	 b. 60	 c. 8	 d. 1	 e. 5.68
	 f. Excel 2021	 g. Open	 h. 7
3.	 a. #DIV/0! error. 	 b. #NUM! error. 	 c. #REF! error. 	 d. #VALUE! error. 
	 e. #VALUE! error.
4.	 a.	A cell reference is a cell address that can be used in a formula to denote a specific cell.
	 b.	(i) All Excel functions must begin with = sign.
		  (ii) Function name must be a valid Excel name.
	 c.	The SUM function returns the sum of a range.
	 d.	The syntax of this function is CONCATENATE (text1, text2). It is used to join together two or 

more different text strings.  
		  Example of CONCATENATE function is given below: 
		  Input: =CONCATENATE (“Touch”, “pad”) 
		  Output: Touchpad
	 e.	Steps for SUM() function in Excel are: 
		  1   Select an empty cell to hold the sum of the numbers.
		  2   Click on Formulas tab.
		  3   Click on the Insert Function command.
		  4   Select SUM in the Select a Function List.
		  5   Click on the OK button.
		  6   �Type the arguments in the number fields which are the range of cells to find the sum of 

their contents.
		  7   Click on OK button.

2.

 

5.	 a.	Relative Cell Referencing: In relative cell reference, you actually refer to the cell that is above 
or below and left or right to a number of rows or columns. When a formula is copied to a 
new location in a worksheet, the value in the copied cell also changes.

		  Absolute Cell Referencing: In absolute cell referencing, cell references in the formula remain 
the same even if we copy and paste the formula to a new location. It is used when you 
maintain the original references as they were.

	 b.	Comparison Operators: These operators are used to compare two values with the given set 
of operators. When two values are compared by using these operators, the result is either 
True or False. Some comparison operators are = (equal to), > (greater than), < (less than), 
>= (greater than equal to), <= (less than equal to) and <> (not equal to).

		  Reference Operators: These operators are used to combine a range of cells for calculations. 
Some reference operators are colon(:) (range operator), comma(,) (union operator), space 
(intersection operator). Range operator produces one reference to all the cells between two 
references. Union operator combines multiple references into one reference. Intersection 
operator produces a reference to cells common to the two references.

6.	 a.	Adhyay should use the =RIGHT function. The syntax of RIGHT function is: 
		  Input: =RIGHT("9988776655",3) 
		  Output: 655 
	 b.	Gaurav should use comparison operator (=) to do so.
	 c.	The #DIV/0! error occurs when the divisor is 0, as division by zero is not possible. To fix it,   

Riya can use the formula =IFERROR(A1/B1, "Error: Division by zero") to handle the error 
gracefully.

	 d.	Tara should use the IF function in Excel, structured as:
		  =IF(score > 50, "Passed", "Failed"), where score is the cell reference.
	 e.	The #REF! error appears when a referenced cell is deleted. To avoid this, Simran should    

ensure the referenced cell is not deleted or update the formula to use valid cell references.

	Advanced Features of Excel 2021

1.	 a. (ii)	 b. (iii)	 c. (iv)	 d. (ii) 	 e. (iii)
	 f. (ii)	 g. (iii)	 h. (ii)	 i. (i)
2.	 a. X 	 b. Line	 c. Legend	 d. Gridlines	 e. Shift
	 f. Filter	 g. IF	 h. Custom Sort	 i. Sort A to Z
3.	 a. F	 b. T 	 c. F	 d. T 

3.
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5.	 a.	Relative Cell Referencing: In relative cell reference, you actually refer to the cell that is above 
or below and left or right to a number of rows or columns. When a formula is copied to a 
new location in a worksheet, the value in the copied cell also changes.

		  Absolute Cell Referencing: In absolute cell referencing, cell references in the formula remain 
the same even if we copy and paste the formula to a new location. It is used when you 
maintain the original references as they were.

	 b.	Comparison Operators: These operators are used to compare two values with the given set 
of operators. When two values are compared by using these operators, the result is either 
True or False. Some comparison operators are = (equal to), > (greater than), < (less than), 
>= (greater than equal to), <= (less than equal to) and <> (not equal to).

		  Reference Operators: These operators are used to combine a range of cells for calculations. 
Some reference operators are colon(:) (range operator), comma(,) (union operator), space 
(intersection operator). Range operator produces one reference to all the cells between two 
references. Union operator combines multiple references into one reference. Intersection 
operator produces a reference to cells common to the two references.

6.	 a.	Adhyay should use the =RIGHT function. The syntax of RIGHT function is: 
		  Input: =RIGHT("9988776655",3) 
		  Output: 655 
	 b.	Gaurav should use comparison operator (=) to do so.
	 c.	The #DIV/0! error occurs when the divisor is 0, as division by zero is not possible. To fix it,   

Riya can use the formula =IFERROR(A1/B1, "Error: Division by zero") to handle the error 
gracefully.

	 d.	Tara should use the IF function in Excel, structured as:
		  =IF(score > 50, "Passed", "Failed"), where score is the cell reference.
	 e.	The #REF! error appears when a referenced cell is deleted. To avoid this, Simran should    

ensure the referenced cell is not deleted or update the formula to use valid cell references.

	Advanced Features of Excel 2021

1.	 a. (ii)	 b. (iii)	 c. (iv)	 d. (ii) 	 e. (iii)
	 f. (ii)	 g. (iii)	 h. (ii)	 i. (i)
2.	 a. X 	 b. Line	 c. Legend	 d. Gridlines	 e. Shift
	 f. Filter	 g. IF	 h. Custom Sort	 i. Sort A to Z
3.	 a. F	 b. T 	 c. F	 d. T 
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4.	 a. Value axis 	 b. Line Chart 	 c. Doughnut Chart 	 d. Scatter Chart 

	 e. Plot Area 	 f. Format Selection	 g. Sorting	 h. Filtering

	 i. Conditional Formatting	 j. Formulas

5.	 a.	Charts in Excel are a pictorial representation of data and are also called graphs. The two 
commonly used charts are Column chart and Bar Chart.

	 b.	The two advantages of using charts are: 

	 	 • A lot of information can be displayed in an easy-to-understand format. 

	 	 • Data can be presented in an attractive way to attract the attention of readers.

	 c.	To change the background, follow the given steps:

		  1   Select the chart and click on the Format tab.

		  2   Click on the Format Selection command.

		  3   Click on the Fill section.

		  4   Click on the Picture or texture fill option button.

	 d.	Gridlines makes it easier for users to read and understand the values.

	 e.	To move the chart, click on the blank area in the chart. It gets automatically surrounded with 
borders and handles. Now you can easily click and drag the chart to the desired new location.

	 f.	 To apply filters, follow the steps given below: 

		  1   Click on the Sort & Filter command. 

		  2   Select the Filter option from the drop-down list. 

	 	    � The list appears with the drop-down controls or the Filter switches on the right side of 
the column headings. 

		  3   Click on Filter Switch. 

		  4   Tick the desired checkbox. 

		  5   Click on the OK button.

	 g.	To use Custom Sorting, follow the steps given below: 

		  1   Select a column or range of the data to be sorted. 

		  2   Click on the Sort & Filter command. 

		  3   Select the Custom Sort option. 

		  4   Click on the Add Level button to add another column to sort. 

		  5   Click on Then by down arrow in the Column section. 
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		  6   Click on the OK button.

	 h.	Conditional formatting in Excel automatically changes cell appearance based on specified 
rules or conditions. To apply conditional formatting to a series of data, follow the given steps: 

		  1   Select the data and click on the Conditional Formatting command. 

		  2   Select the desired option. 

		  3   Choose desired fill effect.

	 i.	 Data can be sorted in two ways: 

		  Ascending order: Arranging data in increasing order, for example, letters from A to Z, numbers 
from lowest to highest, etc. 

		  Descending order: Arranging data in decreasing order, for example, letters from Z to A, 
numbers from highest to lowest, etc.

6.	 a.	Bar Chart

	 b.	Scatter Chart

	 c.	Scatter Chart

	 d.	Line Chart

	 e.	The horizontal and vertical lines in a chart are called gridlines. They help make it easier to read 
and understand the values in the chart by providing a visual reference for the data points.

	  f.	Sara can use Conditional Formatting to highlight the scores above 90. She can select the 
data, click on the Conditional Formatting command, and choose the desired option, such as 
applying a colour to values greater than 90.

	 g.	Raj can use the IF() function as follows:

		  =IF(score >= 60, "Pass", "Fail")

		  This will label the student as "Pass" if their score is 60 or above and "Fail" if below

		  h. Sonal should use the Custom Sort feature in Excel. She can select the data, click on the Sort 
& Filter command, choose Custom Sort, and select Name to sort by Name while keeping the 
Roll No. order intact.

	 i.	 To remove the filters, Amit should click on the Sort & Filter command and select the Clear 
Filter option.

	 j.	 Riya can use Conditional Formatting to highlight scores above 80. She can select the data, 
click on the Conditional Formatting command, and choose an option to fill cells with a special 
colour if the score is greater than 80.
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	Getting Creative with Canva

1.	 a. (iii)	 b. (iii) 	 c. (iii) 	 d. (i)	 e. (ii)
2.	 a. Object Panel	 b. Uploads	 c. Canva Editor	 d. Canva	 e. Tools
3.	 a. T	 b. F 	 c. F 	 d. F	 e. T
4.	 a. A template is a pre-designed layout that simplifies designing by letting you customise it to 

create your own design. 
	 b.	Canva is a popular online graphic design platform that allows users to create a wide range 

of visual content, including presentations, posters, social media graphics, documents and 
more. 

	 c.	The two key features of Canva are: 

	 	 • Canva is easy to use, allowing beginners to create graphics, presentations, and more. 

	 	 • Canva offers a free version for students and a paid version with additional tools and features. 

	 d.	The use of any two components present on the home page of Canva are: 

	 	 • Create: Lets you start a new design or use a template. 

	 	 • Templates: Offers thousands of templates for various design types on the left panel. 

	 e.	Header contains tools for managing your design (e.g., File, Resize, Undo, Redo, Save, Share), 
while Footer provides options like zoom, grid view, full-screen mode and page navigation.

5.	 a.	Fahim can use the Elements tab to find icons and images related to cyber safety, such as 
shields, computers, and locks. 

	 b.	Priyanshi can use the Footer section to add page numbers, date, and contact details across 
all pages.

	 c.	Vanshika can use Canva AI to quickly get creative suggestions for her poster. By entering a 
prompt in the Canva AI box, she can get various design ideas and customize them further to 
fit her needs.

	 d.	Aman should follow these steps in Canva to download his social media post as a JPG:

		  1   Click on the File Menu. 

		  2   Click on the Download option. 

		  3   Select JPG as the file type. 

		  4   Click on the Download button.

4.

 

	 e.	Neha can quickly find and continue editing her saved design in Canva by clicking on the 
Projects tab. This gives her access to her saved designs, allowing her to pick up where she 
left off.

	Algorithms, Flowcharts and System Maps

1.	 a. (i)	 b. (iii) 	 c. (ii) 	 d. (ii) 	 e. (ii)
2.	 a. Process	 b. Flowchart	 c. Flow Line / Arrow
	 d. Cause-and-effect 	 e. Debugging
3.	 a. F	 b. T	 c. T	 d. F		  e. T
4.	 a.	An algorithm is a set of step-by-step instructions or rules designed to perform a specific task 

or solve a problem.
	 b.	A system map is a visual tool that shows how different parts of a system are connected and 

affect each other.
	 c.	A flowchart is a diagram that uses shapes and arrows to show steps in an algorithm. It displays 

the steps in order and helps us understand and check instructions quickly.
	 d.	Two components of system map are: 
	 	 •  Elements: Parts or variables in the system (e.g., CPU speed, software efficiency). 
	 	 •  Feedback Loops: Outputs loop back as inputs.
	 e.	Debugging is the process of finding and fixing errors in a program. 
		  The skills necessary for debugging are: 
	 	 •  logical thinking, problem solving, attention to detail, and careful step-by-step planning.
5.	 a.	Karthik will need to use logical thinking and step-by-step planning to debug the programme 

and put the calculation steps in the correct order.
	 b.	The company can use a system map. This will show the relationships between stock levels 

and the sales rate and help identify areas for improvement.
	 c.	 It is a negative (–) relationship, shown as more programs less memory in the system map.
	 d.	The key elements are Password Strength, Use of Two-Factor Authentication (2FA), Number 

of Accounts, Security Awareness, Risk of Hacking and Personal Data Leaked.
	 e.	The guidelines violated are not leaving an arrow without a destination and using uniform 

shapes; the student should connect all arrows properly and use equal shapes and spacing.

5.
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	Getting Creative with Canva

1.	 a. (iii)	 b. (iii) 	 c. (iii) 	 d. (i)	 e. (ii)
2.	 a. Object Panel	 b. Uploads	 c. Canva Editor	 d. Canva	 e. Tools
3.	 a. T	 b. F 	 c. F 	 d. F	 e. T
4.	 a. A template is a pre-designed layout that simplifies designing by letting you customise it to 

create your own design. 
	 b.	Canva is a popular online graphic design platform that allows users to create a wide range 

of visual content, including presentations, posters, social media graphics, documents and 
more. 

	 c.	The two key features of Canva are: 

	 	 • Canva is easy to use, allowing beginners to create graphics, presentations, and more. 

	 	 • Canva offers a free version for students and a paid version with additional tools and features. 

	 d.	The use of any two components present on the home page of Canva are: 

	 	 • Create: Lets you start a new design or use a template. 

	 	 • Templates: Offers thousands of templates for various design types on the left panel. 

	 e.	Header contains tools for managing your design (e.g., File, Resize, Undo, Redo, Save, Share), 
while Footer provides options like zoom, grid view, full-screen mode and page navigation.
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shields, computers, and locks. 

	 b.	Priyanshi can use the Footer section to add page numbers, date, and contact details across 
all pages.

	 c.	Vanshika can use Canva AI to quickly get creative suggestions for her poster. By entering a 
prompt in the Canva AI box, she can get various design ideas and customize them further to 
fit her needs.
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		  1   Click on the File Menu. 

		  2   Click on the Download option. 
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		  4   Click on the Download button.

4.

 

	 e.	Neha can quickly find and continue editing her saved design in Canva by clicking on the 
Projects tab. This gives her access to her saved designs, allowing her to pick up where she 
left off.
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1.	 a. (i)	 b. (iii) 	 c. (ii) 	 d. (ii) 	 e. (ii)
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or solve a problem.
	 b.	A system map is a visual tool that shows how different parts of a system are connected and 

affect each other.
	 c.	A flowchart is a diagram that uses shapes and arrows to show steps in an algorithm. It displays 

the steps in order and helps us understand and check instructions quickly.
	 d.	Two components of system map are: 
	 	 •  Elements: Parts or variables in the system (e.g., CPU speed, software efficiency). 
	 	 •  Feedback Loops: Outputs loop back as inputs.
	 e.	Debugging is the process of finding and fixing errors in a program. 
		  The skills necessary for debugging are: 
	 	 •  logical thinking, problem solving, attention to detail, and careful step-by-step planning.
5.	 a.	Karthik will need to use logical thinking and step-by-step planning to debug the programme 

and put the calculation steps in the correct order.
	 b.	The company can use a system map. This will show the relationships between stock levels 

and the sales rate and help identify areas for improvement.
	 c.	 It is a negative (–) relationship, shown as more programs less memory in the system map.
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shapes; the student should connect all arrows properly and use equal shapes and spacing.

5.

 



Logicode (Ver. 5.0)-VI (Answer Key)8

	HTML5–Getting Started

1.	 a. (iii) 	 b. (ii)	 c. (iii)	 d. (iii)	 e. (ii)

2.	 a. Website	 b. Notepad	 c. Container tags	 d. Angle	 e. <BODY>

3.	 a. F	 b. F 	 c. T	 d. F	 e. T

4.	 a.	A web page is a single page on the Internet with text, images, videos, or links. While website 
is a collection of linked web pages under one address, written in HTML.

	 b.	The <HEAD> tag contains metadata about the web page. It includes tags that provide 
information about the web page but are not displayed directly on the page itself.

	 c.	To create and save an HTML document, follow the given steps:

		  1   Open the Notepad text editor and write the HTML code.

		  2   Click on the File menu from the Menu bar.

		  3   Click on the Save option from the drop-down menu.

		      The Save as dialog box appears on the screen.

		  4   Choose the location where you want to save the document.

		  5   �Type the desired name for your document in the File name text box, followed by the 
.html extension.

		  6   Click on the Save button.

	 d.	Container tags have opening and closing tags that enclose data. The closing tag has a forward 
slash, while an empty tag is a tag that does not have a closing tag. It is used by itself to add 
something to a web page.

	 e.	HTML comments add explanations in code and are not shown on the web page. They start 
with <!-- and end with -->.

5.	 a.	Revati should use the HTML comment feature. Comments allow you to write notes or messages 
inside the HTML code that are not displayed on the web page.

	 b.	Anirban should use the <br> (line break) tag. This tag moves the text to the next line without 
creating a new paragraph.

	 c.	She should go to the folder where the file is saved and double-click the file to open it in a 
web browser.

6.
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	HTML5–Getting Started

1.	 a. (iii) 	 b. (ii)	 c. (iii)	 d. (iii)	 e. (ii)

2.	 a. Website	 b. Notepad	 c. Container tags	 d. Angle	 e. <BODY>

3.	 a. F	 b. F 	 c. T	 d. F	 e. T

4.	 a.	A web page is a single page on the Internet with text, images, videos, or links. While website 
is a collection of linked web pages under one address, written in HTML.

	 b.	The <HEAD> tag contains metadata about the web page. It includes tags that provide 
information about the web page but are not displayed directly on the page itself.

	 c.	To create and save an HTML document, follow the given steps:

		  1   Open the Notepad text editor and write the HTML code.

		  2   Click on the File menu from the Menu bar.

		  3   Click on the Save option from the drop-down menu.

		      The Save as dialog box appears on the screen.

		  4   Choose the location where you want to save the document.

		  5   �Type the desired name for your document in the File name text box, followed by the 
.html extension.

		  6   Click on the Save button.

	 d.	Container tags have opening and closing tags that enclose data. The closing tag has a forward 
slash, while an empty tag is a tag that does not have a closing tag. It is used by itself to add 
something to a web page.

	 e.	HTML comments add explanations in code and are not shown on the web page. They start 
with <!-- and end with -->.

5.	 a.	Revati should use the HTML comment feature. Comments allow you to write notes or messages 
inside the HTML code that are not displayed on the web page.

	 b.	Anirban should use the <br> (line break) tag. This tag moves the text to the next line without 
creating a new paragraph.

	 c.	She should go to the folder where the file is saved and double-click the file to open it in a 
web browser.

6.

 

	 d.	He should press the F5 key to view the latest changes in the browser.

	 e.	He should choose a WYSIWYG editor, as it shows the final appearance while designing using 
graphical tools.

	CSS3–Styling Basics

1.	 a. (i)	 b. (iii)	 c. (ii) 	 d. (iii) 	 e. (i)

2.	 a. Declaration	 b. <STYLE>, <HEAD>	 c. #FFFFFF

	 d. BORDER-STYLE	 e. Property

3.	 a. T	 b. T	 c. F	 d. F	 e. T

4.	 a.	The same style can be reused across pages, simplifying updates and management.

	 b.	In CSS, a declaration block is a set of one or more declarations enclosed in curly braces {}.

	 c.	There are three main ways to add CSS to your web page: Inline CSS, Internal CSS and External 
CSS.

	 d.	BORDER-WIDTH property has the values THICK, THIN, MEDIUM, Numeric values with PX or 
EM. It sets the width of an element’s border.

	 e.	In CSS, margin properties are used to create space around elements, outside of their borders.

5.	 a.	The issue with Samantha’s CSS code is that italicize is not a valid value for the font-style 
property. The correct value to italicize text is italic.

	 b.	Shaan should use the margin property. The margin property adds space around an element, 
outside its border.

	 c.	Riya should use Inline CSS, which is added directly to the HTML tag using the STYLE attribute 
to apply a unique style to a single element.

	 d.	Aman should use:

	 	 •  FONT-SIZE to control the size of the text 

	 	 •  FONT-WEIGHT to set the thickness (boldness) of the text 

	 	 •  FONT-STYLE to define the style such as italic or oblique 

	 e.	He should use the margin properties to create space around elements, which add space 
outside the borders on all sides to improve layout. 

7.
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	Using Makecode Arcade

1.	 a. (iii)	 b. (i)	 c. (ii)	 d. (iii)	 e. (iii)
	 f. (ii)
2.	 a. Pseudocode	 b. Dictionary	 c. say	 d. MakeCode Arcade
	 e. Event handler
3.	 a. T	 b. F 	 c. T	 d. F	 e. T
4.	 a.	The block toolbox is your source for all the necessary code elements to create your game. 

These elements are neatly categorised in drawers based on their functions and methods.
	 b.	Integrated Development Environment.
	 c.	Pseudocode is used to describe the steps of an algorithm in a human-understandable language. 

It has no syntax and can be easily understood by a layman.

	 d.	To create a simple interaction between two sprites in MakeCode Arcade, Follow the given 
steps:

	 	 1   Click on the Sprites blocks category.

	 	 2   �Drag the set to sprite of kind block from Sprites block category and drop it inside the on 
start block.

	 	 3   Click on the image icon and select the sprite you want to add from Gallery.

	 	 4   �Drag the set position block from Sprites block category and drop it below the set to sprite 
of kind block.

	 	 5   Change the position of mySprite x axis from 0 to 43 and y axis from 0 to 48.

	 	 6   Drag the say block from Sprites block category and drop it below the set position block.

	 	 7   Type the Hello. How are you? message in the say block.

	 	 8   Click on the Loops blocks category.

	 	 9   Drag the pause block and drop it below the say block.

	 	 10   Set the duration to 2000 milliseconds (2 seconds).

	 	 11   �Drag the set to sprite of kind block from Sprites block category and drop it below the 
pausea block.

	 	 12   Click on the image icon and select the another sprite you want to add from Gallery.

8.
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	Using Makecode Arcade

1.	 a. (iii)	 b. (i)	 c. (ii)	 d. (iii)	 e. (iii)
	 f. (ii)
2.	 a. Pseudocode	 b. Dictionary	 c. say	 d. MakeCode Arcade
	 e. Event handler
3.	 a. T	 b. F 	 c. T	 d. F	 e. T
4.	 a.	The block toolbox is your source for all the necessary code elements to create your game. 

These elements are neatly categorised in drawers based on their functions and methods.
	 b.	Integrated Development Environment.
	 c.	Pseudocode is used to describe the steps of an algorithm in a human-understandable language. 

It has no syntax and can be easily understood by a layman.

	 d.	To create a simple interaction between two sprites in MakeCode Arcade, Follow the given 
steps:

	 	 1   Click on the Sprites blocks category.

	 	 2   �Drag the set to sprite of kind block from Sprites block category and drop it inside the on 
start block.

	 	 3   Click on the image icon and select the sprite you want to add from Gallery.

	 	 4   �Drag the set position block from Sprites block category and drop it below the set to sprite 
of kind block.

	 	 5   Change the position of mySprite x axis from 0 to 43 and y axis from 0 to 48.

	 	 6   Drag the say block from Sprites block category and drop it below the set position block.

	 	 7   Type the Hello. How are you? message in the say block.

	 	 8   Click on the Loops blocks category.
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	 	 11   �Drag the set to sprite of kind block from Sprites block category and drop it below the 
pausea block.

	 	 12   Click on the image icon and select the another sprite you want to add from Gallery.

8.

 

	 	 13   �Drag the set position block from Sprites block category and drop it below the set to sprite 
of kind block.

	 	 14   Change the position of mySprite2 x axis from 0 to 118 and y axis from 0 to 76.

	 	 15   Drag the say block from Sprites block category and drop it below the set position block.

	 	 16   Type the Hey, I am Fine! message in the say block.

	 	 17   The output of mySprite will display in the Game Simulator window.

	 	 18   After 2 seconds the output of mySprite2 will display in the Game Simulator window.

	 e.	A bug is an unexpected problem in your program. You follow a defined sequence to write a     
program, from which you expect to return a specific output. Any change in the expected and 
actual output of the program is said to be the result of a bug.

	 f.	

5.	 a.	By creating a sprite using the image editor.
	 b.	Pause Block
	 c.	 Incorrect collision settings or missing solid platform properties.
	 d.	Event handling
	 e.	Event handling and controller input
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	 Introduction to Python

1.	 a. (ii)	 b. (iii) 	 c. (ii) 	 d. (ii) 	 e. (ii)

2.	 a. High-level 	 b. Quotes 	 c. Interpreted 	 d. Operand

3.	 a. Guido Van Rossum 	 b. Object Oriented 		  c. .py

	 d. Integrated Development Learning Environment (IDLE)

4.	 a.	We use the input() function to take the user’s input while a program is being executed.

	 b.	INTERACTIVE MODE (IDLE SHELL WINDOW): The IDLE Shell window is an interactive window 
where we can type Python code and view the output in the same window. In the IDLE Shell 
window, the >>> sign appears. Here, we can type our code and get output by pressing the 
Enter key. 

		  SCRIPT MODE (EDITOR WINDOW): Python Shell does not allow us to save our commands 
written on the command prompt. It gives output immediately after pressing the Enter key. 
If you want to see all the output after the code has been completed, then you can use the 
Python script mode. It also allows you to type multi-line codes that we save for later use.

	 c.	A data type is used to define the type of value a variable can contain. For example, a person’s 
name must be stored as a string value whereas the person’s age must be stored as an integer. 
Commonly used data types in Python are int, float and string.

	 d.	Operators are the special symbols that are used to perform computations. The values which 
the operators use to get the output are called operands. 

		  For example, in the given expression: 20 + 10 

		  20 and 10 are operands and + is an addition operator.

	 e.	To run a Python program, follow the steps given below:

	 	 1   Click on the Run menu.

	 	 2   Click on the Run Module option.

9.
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9.

 

5.	 a.	Yes, they will be able to execute the programs. Portable feature.

	 b.	Run Module option.

	 c.	Sahil's line of code is skipped because the # symbol is used to create single-line comments 
in Python. This tells Python to ignore that line during execution.

	 d.	Anjali can open a new Python file by following these steps:

	 	 1   Click on the File menu. 

	 	 2   Select the New File option to open a new Python file in the editor.

	 e.	Python's dynamic typing feature allows automatic identification of variable types. This means 
Karan doesn't need to specify the data type of a variable, and Python automatically determines 
the type based on the value assigned.


